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Revision History (may not be needed) 

Name Date Reason For Changes Version 
JHotDraw 2004-03-01 

 
Finished adaptation from JHotDraw 5.4b1. 
JHotDraw 7's framework is based now 
entirely on Java idioms. It makes use of 
Java2D, Swing Undo/Redo, XML. The user 
interface is now very close to MS Office 
2002.  

7.0.1 

JHotDraw 2006-01-18 
 

Revived the project. Replaced integer 
coordinate system by a double precision 
coordinate system.  

7.0.2 

JHotDraw 2006-01-29 
 

 Added support for Bézier paths and 
replaced all legacy Polygon code 
with it.  

 Cleaned up the framework. 
CompositeFigure does not 
implement FigureListener anymore.  

 Moved layout strategy for 
ConnectionFigure into a separate 
class named Liner. Added a 
SlantedLiner. ElbowLiner not yet 
implemented.  

 Migrated from Java 1.4 to 1.5. The 
framework uses now type save 
collections.  

 

JHotDraw 2006-06-25 
 

 Reorganized package structure.  
 Added support for type safe Figure 

attributes.  
 Replaced the application framework 

with a new one.  
 Added support for double strokes.  
 Added support for line positions: 

centered, inside, outside.  
 Added more sample figures.  
 Replaced MS Office style icons by a 

7.0.4 



 

 

new open source icon set.  
 Removed dependency to NanoXML 

library.  
 Removed dependency to JGoodies 

Looks library.  

JHotDraw 2006-06-26 
 

Removed copyright notice of NanoXML and 
JGoodies Looks from Draw Application and 
Draw Applet.  

7.0.4_1 
 

JHotDraw 2006-07-30 
 

 Moved all packages from 
ch.randelshofer to org.jhotdraw.  

 Reimplemented the 'Net' and 'Pert' 
sample applications.  

 Implemented an 'SVG' sample 
application.  

 Fixed minor issues here and there.  
 Added a tweaked version fo 

NanoXML back into the framework. 
The tweaked version of NanoXML 
allows to read XML documents 
which have a DTD, without opening 
a network connection to the DTD 
document and thus improving 
performance when opening a XML 
document. Once we figure out, how 
can use the javax.xml API in a more 
performant way, we might throw 
out NanoXML again.  

7.0.5 

JHotDraw 2006-08-27 
 

 Renamed PlasmaDraw to JHotDraw 
7.  

 Changed copyright notices in all 
source files.  

 

JHotDraw 2006-11-12 
 

 Reorganized file structure.  
 Fixed NetBeans project files and Ant 

build scripts.  
 Fixed guide.  

7.0.7 
 

JHotDraw 2007-01-10 
 

 Streamlined interface names and 
class names to make it easier to 
learn the framework.  

 InputFormat/OutputFormat 
interfaces and default 
implementations added to drawing 
framework.  

 ImageHolderFigure interface and 
ImageFigure default implementation 
added to drawing framework.  

7.0.8 
 



 

 

 Enhanced SVG sample application.  
 Removed NanoXML-Lite library.  
 All code is now compilable with 

J2SE6. The minimum platform 
requirements for JHotDraw 7 
remains J2SE5.  

JHotDraw 2007-06-21 
 

 Redesigned Undo/Redo handling for 
Figure attributes.  

 Made many incompatible changes in 
all packages in order to pave the 
way for SVG support.  

 Rewrote the SVG sample 
application. 

 Enhanced the Draw package to 
make support for transformations 
on Figures possible, in order to be 
able to support SVG.    

 Added Batik gradient classes, in 
order to be able to support SVG.  

 Added new package 
org.jhotdraw.application based on 
JSR-296 "appframework" version 
0.42. This package will replace 
org.jhotdraw.app in future versions.  

7.0.9 
 

JHotDraw 2008-03 
 

Substantial changes have been made to fix 
shortcomings and bugs of the frameworks. 
Please take a look at the JDiff report for a 
detailed description of all API changes 
between JHotDraw 7.0.9 and 7.1. 

Drawing Framework: 

 Most Figure methods with prefix 
basic… have been removed. These 
methods were used to support 
Undo/Redo by the Figure objects. In 
JHotDraw 7.1, this task has been 
moved to the Tool objects. 

 The class structure has been 
modified to gain more flexibility. 
Most notably, the Drawing interface 
extends now from the 
CompositeFigure interface. 

Application Framework: 

 The experimental application 

7.1 
 

http://www.randelshofer.ch/oop/jhotdraw/changes/jhotdraw_7.0.9_vs_7.1/changes.html


 

 

framework based on JSR-296 has 
been removed, because it is not 
mature enough yet, to keep 
JHotDraw in sync with it. 

 The Project interface has been 
renamed to View, to be more in line 
with the upcoming Swing application 
framework JSR-296. 

Samples: 

 SVG: The background colors of SVG 
drawings can be set now. A number 
of bugs related to reading and 
writing gradients has been fixed. 
There is no support for editing 
gradients yet. 

 ODG: This sample is not functional 
yet. It consists only of a few 
skeleton classes. 

 

JHotDraw 2009-05 
 

Substantial changes and enhancements 
have been made to fix shortcomings and 
bugs of the frameworks and to improve the 
usability of drawing editors. 
Please take a look at the JDiff report for a 
detailed description of all API changes 
between JHotDraw 7.1 and 7.2. 

Drawing Framework: 

 The type safety of figure attributes 
has been improved, by making use 
of type tokens in AttributeKey and 
setter and getter methods with 
templates in Figure. 

 The usability has been improved. 
Figures indicate there bounds when 
the mouse is moved over them. A 
substantial number of user interface 
classes for the creation of toolbars 
have been added, and are used by 
the SVG sample application. 

7.2 
 

http://www.randelshofer.ch/oop/jhotdraw/changes/jhotdraw_7.1_vs_7.2/changes.html


 

 

 Drawing objects can now be 
serialized using the 
SerializationInputOutputFormat. 
This allows to easily implement 
short-term persistence for drawings 
(for example for clipboard support). 

Application Framework: 

 The resource support has been 
reimplemented to be closer to JSR-
296. Resource bundles can now use 
place holders in their values. The 
resource keys used by JHotDraw 
match now with the correspoinding 
JavaBeans property names. 

 

JHotDraw 2009-10-11 
 

Substantial changes and enhancements 
have been made to fix shortcomings and 
bugs of the frameworks and to improve the 
usability of drawing editors. 
Please take a look at the JDiff report for a 
detailed description of all API changes 
between JHotDraw 7.2 and 7.3. 

Notable changes are: 

General: 

 The documentation of framework 
interfaces and classes shows now 
the design patterns being used(like 
JHotDraw 6 did). 

Drawing Framework: 

 The method names for setting and 
getting an attribute from a Figure 
have been shortened to 
get(AttributeKey), 
set(AttributeKey,Object). The 
sample code uses now these 
methods instead of the setter and 
getter methods in class 
AttributeKey. 

7.3 
 

http://www.randelshofer.ch/oop/jhotdraw/changes/jhotdraw_7.2_vs_7.3/changes.html


 

 

 DefaultDrawingView uses now 
double buffering to improve editing 
performance. 

Application Framework: 

 The Worker class has been 
redesigned, to better support the 
common use cases of a Worker. 

 Support for weak event listeners 
has been added to class 
AbstractBean. Weak event listeners 
help to prevent memory leaks in 
applications. 

Sample applications: 

 SVG Sample: SVG Tiny 1.2 
compliance has been improved. The 
SVGDrawingPanel can now more 
easily integrated as a component 
into an application. 

 

JHotDraw 2009-10-18  This version fixes bugs found in 7.3. 

Notable enhancements: 

 Default input map and action map 
are now handled by the 
DrawingEditor instead by 
AbstractTool. 

Notable fixes: 

 Copy and paste did not work on Mac 
OS X 10.6. 

 Figures which were very small 
caused rendering artefacts on 
DefaultDrawingView and caused 
ImageOutputFormat to crash. 

 Setting a drawing on 
DefaultDrawingView caused 
flickering. 

 

7.3.1  

JHotDraw 2010-01-16 Enhancements: 7.4 



 

 

  Application Framework:  
The application framework works 
now with URI objects instead of File 
objects. This allows the creation of 
applications which are not file-
based, such as network-based 
applications (browsers) and 
database-oriented applications. 

Changes: 

 Application Framework 
Actions in the application framework 
are now organised in an ActionMap 
hierarchy. 
(File-)URIChoosers are now created 
by the ApplicationModel instead by 
the View. 

 Drawing Framework 
The package org.jhotdraw.draw has 
been split up into sub-packages. 

 Platform requirements:  
Minimum platform requirement is 
now J2SE6.  
The following third-party libraries 
have been removed: 
MRJAdapter.jar, swing-layout.jar. 
The following third-party source files 
have been removed: 
LinearGradientPaint and 
RadialGradientPaint from the 
Apache Batik library. 

 

 

JHotDraw 2010-07-28 
 

Enhancements and Changes: 

 Drawing Framework 
InputFormat and OutputFormat 
work now with URI's instead of files 
for identifying the storage location 
of a drawing. 
The ResizeHandleKit supports now 
aspect preserving resizing by 

7.5 
 



 

 

pressing the Alt- or Ctrl-Key. 
The canvas area is now drawn by 
Drawing instead of DrawingView.  
The ButtonFactory can now create 
color chooser popup buttons. 
DOMStorable is not implemented by 
the Figure interface anymore 
allowing the implementation of 
figures which do not depend on this 
persistence framework. 

 User Interface 
An UI delegate for JColorChooser 
has been added to the "Palette" look 
and feel. 
  

 Example applications 
The user interface of the SVG 
example application has been 
improved. 
  

 General 
Java annotations have been added 
for clarity. @Nullable and @NotNull 
annotations specify allowed and 
disallowed occurences of null 
values. This is work in progress. 

 Some changes in the package 
structure and renamings of classes 
have been made in order to improve 
the clarity of the frameworks. 
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1. Introduction 

1.1 Purpose  

In this document are specified the software requirements for JHotDraw graphic design framework 
version 7.6.1. This documents includes functional, non-functional requirements and use cases for 
all features. JHotDraw is a free open source software under the  GNU Library or Lesser General 
Public(LGPL).    

1.2 Document Conventions 

This document was created after the completation of JHotDraw when it was to Beta status so all 
requirments described in the  document are already satisfied.  However it is important to update 
this document with every future requirement to stay informed.  

1.3 Intended Audience and Reading Suggestions 

This Software Requirements document is intended for:  
 General users who wish get informed on what this project can do.It can be used as user manual.  
 Developers who can review project’s capabilities and more easily understand where their efforts  
should be targeted to improve or add more features to it.  
 Project testers who can use this document as a base for their testing strategy as some bugs are 
easier  
to find using a requirements document. This way testing becomes more methodically organized.  

1.4 Project Scope 

JHotDraw is a two-dimensional graphics framework for structured drawing editors that is written in 
Java. It is based on Erich Gamma's JHotDraw, which is copyright 1996, 1997 by IFA Informatik 
and Erich Gamma. JHotDraw is written is Java and that ensures the cross-platform ability.  

1.5 References 

The program, and the source code is available to http://sourceforge.net/projects/jhotdraw/ and 
also at the official site http://www.jhotdraw.org/ . 

2. Overall Description 

2.1 Product Perspective 

JHotDraw started as a closed source program from Erich Gamma and Thomas Eggenschwiler. 
After a while it became free open source softaware and stays so. One of the reason that JHotDraw 

 

http://sourceforge.net/projects/jhotdraw/
http://www.jhotdraw.org/
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became open source is to build new applications based upon JHotDraw like Jarp, Joone, Renew, 
ChemSense that are based on JhotDraw(full list is available at the official site).  

2.2 Product Features 

All the below features of JHotDraw are alreary satisfy because as mentioned before by the time 
this document prepared the program is at beta version. 
Main features: 
 Easy creation of basic shapes. 
 Tools for drawing seperating lines with different forms. 
 Free drawing of closed or open lines 
 Ability to insert and format text. 
 Insert images. 
 Formatting options of all above items. 
 Open/Close/Save/Open Recent Documents. 
 All the fundamental options of navigation between recent actions(Redo/Undo). 
 Adapting the design lines. 
 Toggle Grid design. 
 Easy design of nodes for graphs. 
 Desing of node tasks for creating timing graphs. 

2.3 User Classes and Characteristics 

JHotDraw can be used from developers that want to incorporate it to their applications or to used it 
as a base to build an application. The simplicity of using JHotDraw makes it easy to use to anyone 
that wants to take advantage of the cross-platform and the functionality abilities. 
It can be used  also from kids as an alternative painting program and from profesionals for making 
complex plans and from everyone that wants a framework with advanced abilities of drawing. 

2.4 Operating Environment 

JHotDraw has written is Java so is compatible with all the operating systems ie is platform 
independent(OS independent). It only need jvm.(java virtual machine). 

2.5 Design and Implementation Constraints 

As JHotDraw is a free open source software under the  GNU Library or Lesser General 
Public(LGPL) means that is 100% free and open. Everybody who will involved with it he must 
respect the licence and agree with licence rules. That is the main constraint.    

2.6 User Documentation 

As mentioned before the documents is available at the official site and at Source Forge where you 
can find every information you need. Other information can be found on 1.5 chapter in this 
document. 
Official Site URL: http://www.jhotdraw.org/ 
Source Forge URL: http://sourceforge.net/projects/jhotdraw/  

 

http://www.jhotdraw.org/
http://sourceforge.net/projects/jhotdraw/
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3. Assumptions and Dependencies 

JHotDraw run without installation. Simply unzip the files into a directory of your choice and 
run JHotDraw.jar. So runs on any platform, any operating system. 

4. System Features 

4.1 New Project 

3.1.1 Description and Priority 

  New Project is part of the File Menu. 
  When the program opens a new project is automatically created. So the new  
  project option should only be chosen when we want to close a previous project  
  (saving it or not ) and open a new empty project. 

3.1.2 Stimulus/Response Sequences 

  Data Flow 
   a)User selects File-> Menu 

  b)a new instance of the program open and the other one retain in the  
  backround. 
 

4.2 Open Project 

3.2.1 Description and Priority 

  Open Project is part of the file Menu. 
  User is able to open a previous created file(xml file). 

3.2.2 Stimulus/Response Sequences 

  3.2.2.1 Data Flow  
  Basic Data Flow  
   a) User selects File->Open... 
   b) User is prompted to choose the file that he wants to open 
   c) User chooses the file he wants to open 
   d) User chooses "Open". 
   e) The project loads and opens in the screen. 
  3.2.2.2 Alternative Data Flows  
   Alternative Data Flow 1 
   a) User selects "Cancel" when he is prompted to choose the file that he 
   wants to open 
   b) User returns to the main window, without any changes made.  

 3.2.3 Functional Requirements 

  REQ-1 File selected must be of type the program can read and that is   
  “project_name”.xml 
  REQ-2 A project must have been created before using this feature. 
  

 



Software Requirements Specification for <JHotDraw>  Page 4 

4.3 Open Recent 

3.3.1 Description and Priority 

  Open Recent is part of the file Menu. 
  User is able to open recent closed documents. 

3.3.2 Stimulus/Response Sequences 

  Data Flow  
   a)User selects File->Open Recent->filename.xml 
   b)opens a new instance of the program with the saved file  
 3.3.3 Functional Requirements 
   REQ-1 A file must be created and saved 
   REQ-2 Not Clear Menu has been selected. 
   

4.4 Clear Menu 

3.4.1 Description and Priority 

  Clear Menu is a subment option of Open Recent choice in File Menu. 
  User is able to clear the recent opened or created files. 

3.4.2 Stimulus/Response Sequences 

  Data Flow  
   a) User Selects Menu->Open Recent->Clear Menu 
   b)System clears the list. 

 3.4.3 Functional Requirements 

   REQ-1 A file must be recently created or opened  

4.5 Save Project 

3.5.1 Description and Priority 

  With this function user is able to save his project that contains all the changes that 
  have been made and retrieved in the future 

3.5.2 Stimulus/Response Sequences 

  Data Flow  
3.5.2.1 Basic Data Flow  

  a) User selects File->Save. 

  b) User is prompted to choose a name for the file that he is about to save and a  
  destination 
  c) User enters a name. 
  d) User picks a destination 
  e) User selects save. 
  f) Project is saved. 
  g) User returns to the main window that still shows his project. 
 

3.5.2.2 Alternative Data Flow 1 
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  a)User selects File->Save and the file is saved without any further  
  interaction with the user because the file had already been saved at some  
  point in the past, so there is the name of the file and the destination are  
  already known to the system. 
3.5.2.3 Alternative Data Flow 2 
   a) User selects "Cancel" when he is prompted to enter a name and pick a  
   destination for the project about to be saved 
   b) User returns to the main window without saving the file 
 
   

3.5.3 Functional Requirements 

   REQ-1 Enough disk space. 

4.6 Save As.. 

 

3.6.1 Description and Priority 

  With this function user is able to save his project again under a different name if it 
  has already been saved or just save it if it hasn't. 

3.6.2 Stimulus/Response Sequences 

  Data Flow  

  3.6.2.1 Basic Data Flow 
  a) User selects File->Save as... 

  b) User is prompted to choose a name for the file that he is about to save as well  
 as the location of the file 

  c) User enters a name. 
  d)User picks a location for his file. 
  e) User selects save. 
  f) Project is saved. 
  g) User returns to the main window that still shows his project. 

  3.6.2.2 Alternative Data Flow 1 
  a) User selects "Cancel" when he is prompted to input a name and pick a   
 destination for the project to be saved. 
  b) User returns to the main window that still shows the current project 

 

4.7 Exit 

 

3.7.1 Description and Priority 

With this function user is able to close the whole application. 

3.7.2 Stimulus/Response Sequences 
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Data Flow 
3.7.2.1 Basic Data Flow 
a) User selects File->Exit. 

  b) The program exits 
  3.7.2.2 Alternative Data Flow 1  
  a) User selects File->exit or selects the "X" on the top right corner of the  
  program. 

b) User has made changes to the project he was working on so he is 
prompted to save it. 

  c) User selects "yes". 
  d) User hasn't saved his file again so he is prompted to pick a name and a  
  location for the file about to be saved 
  g) Users hits "Cancel" button. 
  h)His project is not saved. 

i) The program exits.  
3.7.2.3 Alternative Data Flow 2 

  a) User selects File->exit or selects the "X" on the top right corner of the  
  program. 
  b) User has made changes to the project he was working on so he is  
  prompted to save it. 
  c) User selects "no". 

d) The program exits. 
3.7.2.4 Alternative Data Flow 3 
a) User selects File->exit or selects the "X" on the top right corner of the  

  program. 
  b) User has made changes to the project he was working on so he is  
  prompted to save it. 
  c) User selects "Cancel". 

d) The program returns to the previous screen. 

4.8 Undo 

 

3.8.1 Description and Priority 

With this feature the user can negate his last change to his project. 

3.8.2 Stimulus/Response Sequences 

  a)User Selects Edit->Undo or presses Ctrl + Z 
b)The system negates the last acttion made by user to the project. 

 

4.9 Redo 

 

3.9.1 Description and Priority 

With this action the user can undo the last undo. 

3.9.2 Stimulus/Response Sequences 

  a) User Selects Edit->Redo or presses Ctrl + Y 
  b)The system restores the previous state  
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4.10 Cut 

 

3.10.1 Description and Priority 

With this feature system copies the selected item. 

3.10.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)User selects an item by doing a click on it. 
  b)User selects Edit->Copy or presses Ctrl + C 

c)The system copies to the clipboard the selected item 
   

4.11 Paste 

 

3.11.1 Description and Priority 

  With this feature the user can add to the draw the item that has previously copied 
  or cut to clipboard 

3.11.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)User selects Edit-> paste or presses Ctrl + V 
  b) The system pastes the clipboard content 
 
 3.11.3 Functional Requirments 
  REQ-1:The clipboard is not empty 

4.12 Duplicate 

 

3.12.1 Description and Priority 

  With this feature the system duplicates the selected item. The system shows the  
 duplicate item  below the original.  

3.12.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)The user selects an item 
  b)The user selects Edit → Duplicate 
  c) The system adds to the draw a copy of the selected item below it. 
 
 3.12.3 Functional Requirments 
  REQ-1:The user must have selected an item 
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4.13 Delete 

 

3.13.1 Description and Priority 

  The user can delete a selected item. 

3.13.2 Stimulus/Response Sequences 

  Data Flow 
 
  a) The user selects an item. 
  b) The user selects Edit->Delete or presses Delete 
  c) The system deletes the item 
 
 3.13.3 Functional Requirments 
  REQ-1:The user must have selected an item 

4.14 Select All 

 

3.14.1 Description and Priority 

  With this feature the user can selected all the items that exists in the draw. 

3.14.2 Stimulus/Response Sequences 

  Data Flow 
 
  a) The user selects Edit-> Select All or presses Ctrl + A 
  b) The system selects all  the items 
 
 3.14.3 Functional Requirments 
 
  REQ-1:The draw must have at least one item 

4.15 Deselect All 

 

3.15.1 Description and Priority 

  With this feature the user can deselected all the items that are selected. 

3.15.2 Stimulus/Response Sequences 

  Data Flow 
 
  a) The user selects Edit-> Deselect All or presses Ctrl + Shift + A 
  b) The system deselects all  the selected items. 
 
 3.15.3 Functional Requirments 
  REQ-1:TAt least one item should be selected. 
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4.16 Deselect All 

 

3.16.1 Description and Priority 

  With this feature the user can deselected all the items that are selected. 

3.16.2 Stimulus/Response Sequences 

  Data Flow 
 
  a) The user selects Edit-> Deselect All or presses Ctrl + Shift + A 
  b) The system deselects all  the selected items. 
 
 3.16.3 Functional Requirments 
  REQ-1:TAt least one item should be selected. 

4.17 Toolbars 

 

3.17.1 Description and Priority 

  With this menu choice the user can select the toolbars that wants to appear. 

3.17.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)User Selects View->Toolbar 
  b)User selects the toolbar that wants to dissapear/appear. 
  c)The system dissapears/appears the toolbar from the menu 

4.18 Selection Tool 

 

3.18.1 Description and Priority 

  With this tool the user can select an item from the draw.  

3.18.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)User selects the Selection Tool from the Draw Toolbar 
  b)The user clicks on an item. 
  c)The system sets the tool to selected state. 
 
 3.18.3 Functional Requirments 
  REQ-1 The draw must have at least one item. 
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4.19 RectangleTool 

 

3.19.1 Description and Priority 

  With this tool the user can draw a rectangle.  

3.19.2 Stimulus/Response Sequences 

  Data Flow 
  3.19.2.1 Basic Data Flow 
  a)The user selects the Rectangle Tool. 
  b)The user clicks and drags the mouse to draw a rectangle. 
  c)The user lets the mouse to a point different from the start. 
  d)The system sets the item to the selected situation. 
  3.19.2.2 Alternative Data Flow 2 
  a)The user selects the Rectangle Tool. 
  b)The user clicks and drags the mouse to draw a rectangle. 
  c)The user lets the mouse to the same point that began.. 
  d)The system doesn't draw anything 

4.20 Rounded RectangleTool 

 

3.20.1 Description and Priority 

  With this tool the user can draw a rounded rectangle.  

3.20.2 Stimulus/Response Sequences 

  Data Flow 
  3.20.2.1 Basic Data Flow 
  a)The user selects the Rounded Rectangle Tool. 
  b)The user clicks and drags the mouse to draw a rounded rectangle. 
  c)The user lets the mouse to a point different from the start. 
  d)The system sets the item to the selected situation. 
  3.20.2.2 Alternative Data Flow 2 
  a)The user selects the Rounded Rectangle Tool. 
  b)The user clicks and drags the mouse to draw a rounded rectangle. 
  c)The user lets the mouse to the same point that began. 
  d)The system doesn't draw anything 

4.21 Elipse Tool 

 

3.21.1 Description and Priority 

  With this tool the user can draw a elipse.  

3.21.2 Stimulus/Response Sequences 

  Data Flow 
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  3.21.2.1 Basic Data Flow 
  a)The user selects the Elipse Tool. 
  b)The user clicks and drags the mouse to draw a elipse. 
  c)The user lets the mouse to a point different from the start. 
  d)The system sets the item to the selected situation. 
  3.21.2.2 Alternative Data Flow 2 
  a)The user selects the Elipse Tool. 
  b)The user clicks and drags the mouse to draw a elipse. 
  c)The user lets the mouse to the same point that began. 
  d)The system doesn't draw anything 

4.22 Diamond Tool 

 

3.22.1 Description and Priority 

  With this tool the user can draw a diamond.  

3.22.2 Stimulus/Response Sequences 

  Data Flow 
  3.22.2.1 Basic Data Flow 
  a)The user selects the Rounded Diamond Tool. 
  b)The user clicks and drags the mouse to draw a diamond. 
  c)The user lets the mouse to a point different from the start. 
  d)The system sets the item to the selected situation. 
  3.22.2.2 Alternative Data Flow 2 
  a)The user selects the Diamond Tool. 
  b)The user clicks and drags the mouse to draw a diamond. 
  c)The user lets the mouse to the same point that began. 
  d)The system doesn't draw anything 

4.23 Triangle Tool 

 

3.23.1 Description and Priority 

  With this tool the user can draw a Triangle.  

3.23.2 Stimulus/Response Sequences 

  Data Flow 
  3.19.2.1 Basic Data Flow 
  a)The user selects the Triangle Tool. 
  b)The user clicks and drags the mouse to draw a triangle. 
  c)The user lets the mouse to a point different from the start. 
  d)The system sets the item to the selected situation. 
  3.19.2.2 Alternative Data Flow 2 
  a)The user selects the Triangle Tool. 
  b)The user clicks and drags the mouse to draw a triangle. 
  c)The user lets the mouse to the same point that began. 
  d)The system doesn't draw anything 
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4.24 LineTool 

 

3.24.1 Description and Priority 

  With this tool the user can draw a line.  

3.24.2 Stimulus/Response Sequences 

  Data Flow 
  3.24.2.1 Basic Data Flow 
  a)The user selects the Line Tool. 
  b)The user clicks and drags the mouse to draw a line. 
  c)The user lets the mouse to a point different from the start. 
  d)The system sets the item to the selected situation. 
  3.24.2.2 Alternative Data Flow 2 
  a)The user selects the Line Tool. 
  b)The user clicks and drags the mouse to draw a Line. 
  c)The user lets the mouse to the same point that began. 
  d)The system doesn't draw anything 

4.25 ArrowTool 

 

3.25.1 Description and Priority 

  With this tool the user can draw an arrow.  

3.25.2 Stimulus/Response Sequences 

  Data Flow 
  3.25.2.1 Basic Data Flow 
  a)The user selects the Arrow Tool. 
  b)The user clicks and drags the mouse to draw a arrow. 
  c)The user lets the mouse to a point different from the start. 
  d)The system sets the item to the selected situation. 
  3.25.2.2 Alternative Data Flow 2 
  a)The user selects the Arrow Tool. 
  b)The user clicks and drags the mouse to draw a arrow. 
  c)The user lets the mouse to the same point that began. 
  d)The system doesn't draw anything 
 

4.26 Line Connection  Tool 

 

3.26.1 Description and Priority 

  With this tool the user can draw a connection line between two shapes..  

3.26.2 Stimulus/Response Sequences 
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  Data Flow 
  3.26.2.1 Basic Data Flow 
  a)The user selects the Line Connection Tool. 
  b)The user setes the mouse close to the center of the fistr shape 
  c)The system shows the center of the first shape. 
  d)The user clicks and drags the mouse to draw a line from the center of the fisrt  
  shape to the second. 
  e)The system draws a line from the region of the first shpae to the second. 
  3.26.2.2 Alternative Data Flow 1 
  a)The user selects the Line Connection Tool. 
  b)The user setes the mouse close to the center of the fistr shape 
  c)The system shows the center of the first shape. 
  d)The user clicks and drags the mouse to draw a line from the center of the fisrt  
  shape somewhere except from the second shape's region. 
  e)The system doesn't draw the line. 
 
 3.26.3 Functional Requirments 
  REQ-1 The draw must have at least two items. 

4.27 Elbow Connection Tool 

 

3.27.1 Description and Priority 

  With this tool the user can draw a elbow connection between two shapes..  

3.27.2 Stimulus/Response Sequences 

  Data Flow 
  3.27.2.1 Data Flow 
  a)The user selects the Elbow Connection Tool. 
  b)The user setes the mouse close to the center of the fistr shape 
  c)The system shows the center of the first shape. 
  d)The user clicks and drags the mouse to draw a elobow line from the center of the 
  fisrt shape to the second. 
  e)The system draws a elbow line from the region of the first shpae to the second. 
  3.27.2.2 Alternative Data Flow 1 
   a)The user selects the elbow line Connection Tool. 
  b)The user setes the mouse close to the center of the fistr shape 
  c)The system shows the center of the first shape. 
  d)The user clicks and drags the mouse to draw a elbow line from the center of the f
  isrt shape somewhere except from the second shape's region. 
  e)The system doesn't draw the elbow line. 
 
 3.27.3 Functional Requirments 
  REQ-1 The draw must have at least two items. 

4.28 Curve Connection Tool 

 

3.28.1 Description and Priority 
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  With this tool the user can draw a Curve connection between two shapes..  

3.28.2 Stimulus/Response Sequences 

  Data Flow 
  3.28.2.1 Data Flow 
  a)The user selects the Curve Connection Tool. 
  b)The user setes the mouse close to the center of the first shape 
  c)The system shows the center of the first shape. 
  d)The user clicks and drags the mouse to draw a curve line from the center of the 
  fisrt shape to the second. 
  e)The system draws a curve line from the region of the first shpae to the second. 
  3.28.2.2 Alternative Data Flow 1 
   a)The user selects the curve line Connection Tool. 
  b)The user setes the mouse close to the center of the fistr shape 
  c)The system shows the center of the first shape. 
  d)The user clicks and drags the mouse to draw a curve line from the center of the f
  isrt shape somewhere except from the second shape's region. 
  e)The system doesn't draw the curve line. 
 
 3.28.3 Functional Requirments 
  REQ-1 The draw must have at least two items. 

4.29 Scribble Tool 

 

3.29.1 Description and Priority 

  With this tool the user can draw a custom shape or line.  

3.29.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)The user selects the Scribble Tool. 
  b)The user begins to draw by dragging the mouse. 
  c)The system draws the line 
  d)The user clicks and drags the mouse to draw a elobow line from the center of the 
  fisrt shape to the second. 

4.30 Polygon Tool 

 

3.30.1 Description and Priority 

  With this tool the user can draw a custom polygon.  

3.30.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)The user selects the Polygon Tool. 
  b)The user begins to draw by dragging the mouse. 
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  c)The system draws the polygon 

4.31 Text Tool 

 

3.31.1 Description and Priority 

  With this tool the user can insert one line of text.  

3.31.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)The user selects the Text Tool. 
  b)The user clicks at  the spot that he wants to insert the text line. 
  c)The system show a text box with the word “Text” 
  d) The user insert the text and presses Enter. 

4.32 Text Area Tool 

 

3.32.1 Description and Priority 

  With this tool the user can insert multiple lines of text  

3.32.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)The user selects the Text Area Tool. 
  b)The user clicks and drags at  the spot that he wants to insert the text at the  
  preferred size. 
  c)The system show a text area with the word “Text” 
  d)The user insert the text and presses Enter. 

4.33 Image Tool 

 

3.33.1 Description and Priority 

  With this tool the user can insert an image to the draw.  

3.33.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)The user selects the Image Tool. 
  b) A file Chooser widow appears. 
  c) The user selects an image. 
  d)The user clicks and drags at  the spot that he wants to insert the image at the  
  preferred size. 
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4.34 Pick Attributes Tool 

 

3.34.1 Description and Priority 

  With this tool the user can copy the attributes of an item to paint another item.The 
  tool copies the circumference line colour and the fill colour.  

3.34.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)The user selects selection Tool. 
  b) The user selects an item. 
  c) The user selects the Pick atrribute tool.. 
  d)The user clicks on one shape. 
  e)The system copies the atrributes. 

 3.34.3 Functional Requirments 

  REQ-1 The draw must have at least one item. 

4.35 Apply Attributes Tool 

 

3.35.1 Description and Priority 

 With this tool the user can apply the copied attributes of an item to paint another item. 

3.35.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)The user selects selection Tool. 
  b) The user selects an item. 
  c) The user selects the apply atrribute tool.. 
  d)The user clicks on the item. 
  e)The system copies the atrributes to the shape. 

 3.35.3 Functional Requirments 

  REQ-1 The draw must have at least one item. 

4.36 Line Colour 

 

3.36.1 Description and Priority 

 With this tool the user can choose the preferred line colour for the lines or the shapes 
 region. 

3.36.2 Stimulus/Response Sequences 

  Data Flow 
  3.36.2.1 Basic Data Flow 
  a)User selects line colour tool. 
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  b)System shows a small palette of the basic colours (48 colours) 
  c)User selects the colour. 
  3.36.2.2 Alternative Data Flow 1 
  a)User selects line colour tool 
  b)System show a small pallete of the basic colours. 
  c) User selects "No colour" 
  d)System sets the colour to a transparent colour that is not visible. 
  3.36.2.3 Alternative Data Flow 2 
  a)User selects line colour tool 
  b)System shows a small palette of the the basic colour. 
  c)User select Open Colour Chooser 
  d)The system shows the open colour chooser window 
  e)The user chooses a colour from the 279-colour palette from the tab "Swatches". 
  f)The system shows a preview of the colour 
  g)The user selects OK. 
  h)The system sets the line colour to the selected colour 
  3.36.2.4 Alternative Data Flow 3 
  a)User selects the line colour tool 
  b)System shows a small palette of the the basic colour. 
  c)User select Open Colour Chooser 
  d)The system shows the open colour chooser window 
  e)The user chooses a colour from the 279-colour palette from the tab "Swatches". 
  f)The system shows a preview of the colour 
  g)The user selects CANCEL or RESET and the OK or CANCEL. 
  h)The system retains the line colour as it was. 
  3.36.2.5 Alternative Data Flow 4 
  a)User selects the line colour tool 
  b)System shows a small palette of the the basic colour. 
  c)User select Open Colour Chooser 
  d)The system shows the open colour chooser window 
  e)The user selects the tab "HSB" 
  f)The system show the HSB tab. 
  g)The user choose a colour by giving values to H, S and B parametres. 
  h)The system shows a preview of the colour. 
  i)The user selects OK. 
  j) The system sets the colour to the specified colour. 
  3.36.2.6 Alternative Data Flow 5 
  a)User selects the line colour tool 
  b)System shows a small palette of the the basic colour. 
  c)User select Open Colour Chooser 
  d)The system shows the open colour chooser window 
  e)The user selects the tab "HSB" 
  f)The system show the HSB tab. 
  g)The user choose a colour by giving values to H, S and B parametres. 
  h)The system shows a preview of the colour 
  i)The user selects CANCEL or RESET and CANCEL or OK. 
  j)The system retains the line colour as it was. 
  3.36.2.7 Alternative Data Flow 6 
  a)User selects the line colour tool 
  b)System shows a small palette of the the basic colour. 
  c)User select Open Colour Chooser 
  d)The system shows the open colour chooser window 

 



Software Requirements Specification for <JHotDraw>  Page 18 

  e)The user selects the tab "RGB" 
  f)The system show the RGB tab. 
  g)The user choose a colour by giving values to R, G and B parametres. 
  h)The system shows a preview of the colour 
  i)The user selects OK. 
  j) The system sets the colour to the specified colour. 
 
  3.36.2.8 Alternative Data Flow 7 
  a)User selects the line colour tool 
  b)System shows a small palette of the the basic colour. 
  c)User select Open Colour Chooser 
  d)The system shows the open colour chooser window 
  e)The user selects the tab "RGB" 
  f)The system show the RGB tab. 
  g)The user choose a colour by giving values to R, G and B parametres. 
  h)The system shows a preview of the colour 
  i)The user selects CANCEL or RESET and CANCEL or OK. 
  j)The system retains the line colour as it was. 

 

4.37 Fill Colour 

 

3.37.1 Description and Priority 

 With this tool the user can choose the preferred fill colour for the shapes. 

3.37.2 Stimulus/Response Sequences 

  Data Flow 
  3.37.2.1 Basic Data Flow 
  a)User selects line colour tool. 
  b)System shows a small palette of the basic colours (48 colours) 
  c)User selects the colour. 
  3.37.2.2 Alternative Data Flow 1 
  a)User selects line colour tool 
  b)System show a small pallete of the basic colours. 
  c) User selects "No colour" 
  d)System sets the colour to a transparent colour that is not visible. 
  3.37.2.3 Alternative Data Flow 2 
  a)User selects fill colour tool 
  b)System shows a small palette of the the basic colour. 
  c)User select Open Colour Chooser 
  d)The system shows the open colour chooser window 
  e)The user chooses a colour from the 279-colour palette from the tab "Swatches". 
  f)The system shows a preview of the colour 
  g)The user selects OK. 
  h)The system sets the fill colour to the selected colour 
  3.37.2.4 Alternative Data Flow 3 
  a)User selects the fill colour tool 
  b)System shows a small palette of the the basic colour. 
  c)User select Open Colour Chooser 
  d)The system shows the open colour chooser window 
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  e)The user chooses a colour from the 279-colour palette from the tab "Swatches". 
  f)The system shows a preview of the colour 
  g)The user selects CANCEL or RESET and the OK or CANCEL. 
  h)The system retains the fill colour as it was. 
  3.37.2.5 Alternative Data Flow 4 
  a)User selects the fill colour tool 
  b)System shows a small palette of the the basic colour. 
  c)User select Open Colour Chooser 
  d)The system shows the open colour chooser window 
  e)The user selects the tab "HSB" 
  f)The system show the HSB tab. 
  g)The user choose a colour by giving values to H, S and B parametres. 
  h)The system shows a preview of the colour. 
  i)The user selects OK. 
  j) The system sets the colour to the specified colour. 
  3.37.2.6 Alternative Data Flow 5 
  a)User selects the fill colour tool 
  b)System shows a small palette of the the basic colour. 
  c)User select Open Colour Chooser 
  d)The system shows the open colour chooser window 
  e)The user selects the tab "HSB" 
  f)The system show the HSB tab. 
  g)The user choose a colour by giving values to H, S and B parametres. 
  h)The system shows a preview of the colour 
  i)The user selects CANCEL or RESET and CANCEL or OK. 
  j)The system retains the fill colour as it was. 
  3.37.2.7 Alternative Data Flow 6 
  a)User selects the fill colour tool 
  b)System shows a small palette of the the basic colour. 
  c)User select Open Colour Chooser 
  d)The system shows the open colour chooser window 
  e)The user selects the tab "RGB" 
  f)The system show the RGB tab. 
  g)The user choose a colour by giving values to R, G and B parametres. 
  h)The system shows a preview of the colour 
  i)The user selects OK. 
  j) The system sets the colour to the specified colour. 
 
  3.37.2.8 Alternative Data Flow 7 
  a)User selects the fill colour tool 
  b)System shows a small palette of the the basic colour. 
  c)User select Open Colour Chooser 
  d)The system shows the open colour chooser window 
  e)The user selects the tab "RGB" 
  f)The system show the RGB tab. 
  g)The user choose a colour by giving values to R, G and B parametres. 
  h)The system shows a preview of the colour 
  i)The user selects CANCEL or RESET and CANCEL or OK. 
  j)The system retains the fill colour as it was. 

4.38 Text Colour 

 

 



Software Requirements Specification for <JHotDraw>  Page 20 

3.38.1 Description and Priority 

 With this tool the user can choose the preferred text colour. 

3.38.2 Stimulus/Response Sequences 

  Data Flow 
  3.38.2.1 Basic Data Flow 
  a)User selects text colour tool. 
  b)System shows a small palette of the basic colours (48 colours) 
  c)User selects the colour. 
  3.38.2.2 Alternative Data Flow 1 
  a)User selects text colour tool 
  b)System show a small pallete of the basic colours. 
  c) User selects "No colour" 
  d)System sets the colour to a transparent colour that is not visible. 
  3.38.2.3 Alternative Data Flow 2 
  a)User selects text colour tool 
  b)System shows a small palette of the the basic colour. 
  c)User select Open Colour Chooser 
  d)The system shows the open colour chooser window 
  e)The user chooses a colour from the 279-colour palette from the tab "Swatches". 
  f)The system shows a preview of the colour 
  g)The user selects OK. 
  h)The system sets the text colour to the selected colour 
  3.38.2.4 Alternative Data Flow 3 
  a)User selects the text colour tool 
  b)System shows a small palette of the the basic colour. 
  c)User select Open Colour Chooser 
  d)The system shows the open colour chooser window 
  e)The user chooses a colour from the 279-colour palette from the tab "Swatches". 
  f)The system shows a preview of the colour 
  g)The user selects CANCEL or RESET and the OK or CANCEL. 
  h)The system retains the fill colour as it was. 
  3.38.2.5 Alternative Data Flow 4 
  a)User selects the text colour tool 
  b)System shows a small palette of the the basic colour. 
  c)User select Open Colour Chooser 
  d)The system shows the open colour chooser window 
  e)The user selects the tab "HSB" 
  f)The system show the HSB tab. 
  g)The user choose a colour by giving values to H, S and B parametres. 
  h)The system shows a preview of the colour. 
  i)The user selects OK. 
  j) The system sets the colour to the specified colour. 
  3.38.2.6 Alternative Data Flow 5 
  a)User selects the text colour tool 
  b)System shows a small palette of the the basic colour. 
  c)User select Open Colour Chooser 
  d)The system shows the open colour chooser window 
  e)The user selects the tab "HSB" 
  f)The system show the HSB tab. 
  g)The user choose a colour by giving values to H, S and B parametres. 
  h)The system shows a preview of the colour 
  i)The user selects CANCEL or RESET and CANCEL or OK. 
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  j)The system retains the fill colour as it was. 
  3.38.2.7 Alternative Data Flow 6 
  a)User selects the text colour tool 
  b)System shows a small palette of the the basic colour. 
  c)User select Open Colour Chooser 
  d)The system shows the open colour chooser window 
  e)The user selects the tab "RGB" 
  f)The system show the RGB tab. 
  g)The user choose a colour by giving values to R, G and B parametres. 
  h)The system shows a preview of the colour 
  i)The user selects OK. 
  j) The system sets the colour to the specified colour. 
 
  3.38.2.8 Alternative Data Flow 7 
  a)User selects the text colour tool 
  b)System shows a small palette of the the basic colour. 
  c)User select Open Colour Chooser 
  d)The system shows the open colour chooser window 
  e)The user selects the tab "RGB" 
  f)The system show the RGB tab. 
  g)The user choose a colour by giving values to R, G and B parametres. 
  h)The system shows a preview of the colour 
  i)The user selects CANCEL or RESET and CANCEL or OK. 
  j)The system retains the text colour as it was. 

4.39 Arrow Tips Tool 

 

3.39.1 Description and Priority 

 With this tool the user can select the tip of the arrow which is created with the arrow tool. 

3.39.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)The user selects the Arraw Tip tool. 
  b)The user selects the style of the tip. 
  c)The user selects the Arrow tool and draws the arrow. 
  d)The system show the arrow with the selected tip. 

4.40 Stroke Width 

 

3.40.1 Description and Priority 

 With this option the user can change the stroke width. 

3.40.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)The user selects the Stroke Width toolbar option. 
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  b)The user selects the preferred size of the stroke. 

4.41 Line Dashes 

 

3.41.1 Description and Priority 

 With this option the user can add dashes to the lines. 

3.41.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)The user selects the Line Dashes toolbar option. 
  b)The user selects the preferred dash line. 

4.42 Stroke Type 

 

3.41.1 Description and Priority 

 With this option the user can change the stroke type. 

3.41.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)User selects the Stroke type option. 

  b)User selects the preferred stroke type 
  c)The system changes the stroke type to the selected. 

4.43 Stroke Placement 

 

3.43.1 Description and Priority 

 With this option the user can change the stroke placement compared to the rectangle 
 context. 

3.43.2 Stimulus/Response Sequences 

  Data Flow 
 

  a)User selects the Stroke Placement option. 
  b)User selects the preferred stroke placement 
  c)The system changes the stroke placement to the selected. 

4.44 Line Caps 

 

3.44.1 Description and Priority 
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 With this option the user can change the line caps. 

3.44.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)User selects the Line Caps option. 
  b)User selects the preferred cap for the lines 
  c)The system changes the line caps to the selected. 

4.45 Stroke Joint 

 

3.45.1 Description and Priority 

 With this option the user can change the stroke joint. 

3.45.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)User selects the Stroke Joint option. 
  b)User selects the preferred joint for the strokes 
  c)The system changes the stroke joint to the selected. 

4.46 Font Tool 

 

3.46.1 Description and Priority 

 This is a feature that gives the ability to the user to choose a font. 

3.46.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)User selects Font. 
  b)User selects the preferred Collection 
  c)System shows the fonts that make up the collection and a preview. 
  d)User selects one font. 
  e)System shows a preview 
  f)User selects a typeface. 
  g)User selects a typeface 
  h)System shows a preview. 
  i)User presses Enter 

4.47 Bold 
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3.47.1 Description and Priority 

 With this feature the user can change the type of the font to bold. 

3.47.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)User selects the bold option. 
  b)The system changes the font to bold 

4.48 Italic 

 

3.48.1 Description and Priority 

 With this feature the user can change the type of the font to italic. 

3.48.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)User selects the bold option. 
  b)The system changes the font to italic 

4.49 UnderLine 

 

3.49.1 Description and Priority 

 With this feature the user can change the type of the font to UnderLine. 

3.49.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)User selects the bold option. 
  b)The system changes the font to underLine 

4.50 Align Left 

 

3.50.1 Description and Priority 

 With this feature the user can align to left for a couple of item. 

3.50.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)User selects the selection tool 
  b)User selects at least two items 
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  c)User selects align left 
  d)System aligns all the item left. 

 3.50.3 Functional Requirments 

  REQ-1 The draw must have at least two items. 

4.51 Align Right 

 

3.51.1 Description and Priority 

 With this feature the user can align to right for a couple of item. 

3.51.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)User selects the selection tool 
  b)User selects at least two items 
  c)User selects align right 
  d)System aligns all the items right . 

 3.51.3 Functional Requirments 

  REQ-1 The draw must have at least two items. 

4.52 Align Horizontal 

 

3.52.1 Description and Priority 

 With this feature the user can align horizontal  a couple of items. 

3.52.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)User selects the selection tool 
  b)User selects at least two items 
  c)User selects align horizontal 
  d)System aligns all the item horizontal. 

 3.52.3 Functional Requirments 

  REQ-1 The draw must have at least two items. 
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4.53 Align Top 

 

3.53.1 Description and Priority 

 With this feature the user can align top for a couple of items. 

3.53.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)User selects the selection tool 
  b)User selects at least two items 
  c)User selects align top. 
  d)System aligns all the items top. 

 3.53.3 Functional Requirments 

  REQ-1 The draw must have at least two items. 

4.54 Align Bottom 

 

3.54.1 Description and Priority 

 With this feature the user can align bottom for a couple of items. 

3.54.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)User selects the selection tool 
  b)User selects at least two items 
  c)User selects align bottom 
  d)System aligns all the item bottom. 

 3.54.3 Functional Requirments 

  REQ-1 The draw must have at least two items. 

4.55 Align Vertical 

 

3.55.1 Description and Priority 

 With this feature the user can align vertical for a couple of items. 

3.55.2 Stimulus/Response Sequences 

  Data Flow 
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  a)User selects the selection tool 
  b)User selects at least two items 
  c)User selects align Vertical 
  d)System aligns all the items vertical. 

 3.55.3 Functional Requirments 

  REQ-1 The draw must have at least two items. 

4.56 Move Left 

 

3.56.1 Description and Priority 

 With this feature the user can move items to left 

3.56.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)User selects the selection tool 
  b)User selects a couple of items, at least one. 
  c)User selects move left 
  d)System moves the item left one pixel. 

 3.56.3 Functional Requirments 

  REQ-1 The draw must have at least one item. 

4.57 Move Right 

 

3.57.1 Description and Priority 

 With this feature the user can move items to right 

3.57.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)User selects the selection tool 
  b)User selects a couple of items, at least one. 
  c)User selects move right 
  d)System moves the item right one pixel. 

 3.57.3 Functional Requirments 

  REQ-1 The draw must have at least one item. 
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4.58 Move Up 

 

3.58.1 Description and Priority 

 With this feature the user can move items up 

3.58.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)User selects the selection tool 
  b)User selects a couple of items, at least one. 
  c)User selects move up 
  d)System moves the item up one pixel. 

 3.58.3 Functional Requirments 

  REQ-1 The draw must have at least one item. 

4.59 Move Down 

 

3.59.1 Description and Priority 

 With this feature the user can move items down 

3.59.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)User selects the selection tool 
  b)User selects a couple of items, at least one. 
  c)User selects move down 
  d)System moves the item down one pixel. 

 3.59.3 Functional Requirments 

  REQ-1 The draw must have at least one item. 

4.60 Bring To Front 

 

3.60.1 Description and Priority 

 With this feature the user can move items to front 

3.60.2 Stimulus/Response Sequences 

  Data Flow 
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  a)User selects the selection tool 
  b)User selects a couple of items, at least one. 
  c)User selects Bring to Front 
  d)System moves the items to the front in relation to other objects.. 

 3.60.3 Functional Requirments 

  REQ-1 The draw must have at least two items. 

4.61 Send to Back 

 

3.61.1 Description and Priority 

 With this feature the user can move items to back 

3.61.2 Stimulus/Response Sequences 

  Data Flow 
 
  a)User selects the selection tool 
  b)User selects a couple of items, at least one. 
  c)User selects Send To Back 
  d)System moves the items to back  in relation to other objects.. 

 3.61.3 Functional Requirments 

  REQ-1 The draw must have at least two items. 

5. External Interface Requirements 

5.1 User Interfaces 

The following image is a sample of JHotDraw main window with all toolbars. On the top we can see 
the Menu bar with “Menu” ,“Edit”,”View”,”?”. The last one is an about menu item. Below tha we can 
see the Draw, Atrributes and Align toolbars. At the bottom left corner we can see the two options 
for zoom and Toggle Grid tool. 
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JHotDraw also provides some useful shortcuts: 

 New  Ctrl + N 
 Open Ctrl + O 
 Save Ctrl + S 
 Close Ctrl + F4 
 Undo Ctrl + Z 
 Redo Ctrl + Y 
 Cut Ctrl + Z 
 Copy Ctrl + C 
 Paste Ctrl + V 
 Delete Delete 
 Select All Ctrl + A 
 Deselect All Ctrl + Shift + A 

Also with right click program shows a menu with cut, copy, paste and select same choices. 

5.2 Hardware Interfaces 

There are no special hardware Interfaces. JHotDraw needs only keyboard and mouse for use it. 

5.3 Software Interfaces 

The only requirement that JHotDraw needs is Java(J2SE6). 
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5.4 Communications Interfaces 

No communication Interfaces. 

6. Other Nonfunctional Requirements 

6.1 Extensibility 
The framework strictly uses design by contract. Design by contract explicitly allows different 
implementation classes. 
 

6.2 Use of proven development paradigms 
The framework strictly uses of well-documented design patterns and idioms rather than inventing 
the wheel again. 
 

6.3 Support for static code analysis 
Where possible, the framework makes use of type-safe constructs, annotations and static 
dependencies. 
So that many errors can be detected with the compiler, and that correctness can be proven with 
static code analysis tool (for example FindBugs is explicitly supported). 
 

6.4 Early failure 
In case of an implementation error, failure should occur near the cause of the error. 
This goal is not always met, but we are still aiming for it. For example, if the clone method of a 
figure is not implemented properly, the drawing editor starts to behave in a strange way, instead of 
stopping to work right after the buggy clone method was invoked.  
 

6.5 Modularity 
JHotDraw 7 consists of two framework: drawing and application. Each framework can be used 
independently. 
 
6.6 Other 
JHotDraw don’t aim for backwards compatibility. All users of the framework must adapt their code if 
there is a substantial change in the framework. 
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